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Introduction

Welcome to MallinCam Control
MallinCam Control is designed to be a powerful, yet user friendly tool for viewing live images and recording 
still pictures and video clips from your MallinCam Astronomical Video CCD Camera. It provides complete 
camera control, allowing easy adjustment of all camera settings via a serial interface and provides a live video 
preview when combined with the appropriate video digitizing hardware.

The software is available for both Mac OS X and Windows and looks and feels consistent across platforms. 
MallinCam Control is compatible with all versions of MallinCam cameras capable of being computer 
controlled. It requires the use of a standard USB to Serial port adapter (or a built in serial port), and a 
compatible video capture device.
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System Requirements

Operating System
• Mac OS 10.6 (Snow Leopard) or later
• Microsoft® Windows XP (32-bit versions)
• Vista® (32-bit or 64-bit versions)
• Windows 7® (32 bit or 64 bit versions)

Minimum Hardware (Macintosh)
• Any Intel® based Macintosh (PPC Macintosh is no longer supported)
• Memory: 1GB RAM; 2GB or more recommended
• Minimum free drive space: 20MB
• XGA (1024x768) or higher-resolution monitor
• USB serial port adapter
• Video digitizer (optional)

Minimum Hardware (Windows)
• Intel® or AMD x86 processor running at 1.5GHz or higher
• Memory: 1GB RAM; 2GB or more recommended
• Minimum free drive space: 25MB
• XGA (1024x768) or higher-resolution monitor
• Built in serial port or USB serial port adapter
• Video digitizer (optional)
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Installation

Mac OS X
MallinCam Control for Mac OS X is distributed as a standard disk image (.dmg) file. By default, the file will be 
downloaded to your user “Downloads” folder, but it may be placed in another location if you have modified 
your browser settings.

To install, simply double click to mount the disk image (this might have been done for you automatically after 
it finished downloading). Drag the “MallinCam Control” application directly across to the the “Applications” 
folder alias and it will be placed in the Applications folder on your hard drive. Once there, it can be dragged 
to the Dock for easy access. The “MallinCam Settings” folder, and User’s Guide file should be copied to a 
convenient place on your hard drive. Your “Documents” folder is a good place.

Windows
After downloading the MallinCam Control setup program, double click the icon and follow the on screen 
instructions. Depending on your version of Windows, the installer may need to place some files within the 
Windows system folder and might ask you for an administrator password.
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You can specify the folders where application files will be placed, as well as the name of the program 
manager group (Start menu folder). Decide if you would like to add shortcuts to the application in the Start 
menu, Quick Launch bar, or on the Windows desktop. 

When the installer is finished, double-clicking the MallinCam Control icon will launch the application for the 
first time. 

Registering Your Software
Before it is registered, MallinCam Control will operate in a time limited “demo” mode. It will display an 
“Unregistered” watermark over your live video feed and will stop communicating with your MallinCam after 10 
minutes of operation. To remove these limitations, you can purchase a license on the MiloSlick website:

http://www.miloslick.com/Purchase.html
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Within a few minutes after your purchase has been processed (usually in less than one hour), you will receive 
an email with your personalized Registration Code which can be used to unlock the software. If you do not 
receive the email in a timely manner, please check your junk mail folder before contacting our support team.

Click on the "Help > Register MallinCam Control..." (Windows) or “Apple > Register MallinCam 
Control...” (Mac OS X) menu item and enter the User Name and Registration Code from your confirmation 
email. Make sure to type these values exactly as they appears in the email, including any punctuation and 
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upper/lower case characters. We suggest that you copy and paste the values directly into the respective 
fields. When all the fields have been entered, click "Register" and your program will be fully enabled. You will 
NOT need to reinstall or relaunch the software to gain full functionality.

Remember that your MallinCam Control license entitles you to free upgrades to any 2.x release of the 
software, and includes help and support via our online user support forums. There you can look for answers 
to your questions, make suggestions for future releases, or post a helpful response to other MallinCam 
Control users.
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Getting Started

Connecting Your MallinCam
Adjusting camera settings and viewing live images on your MallinCam Astronomical Video CCD camera 
requires the use of two separate cable connections between your computer and camera. Control of 
exposure, color balance and other camera settings is accomplished over a serial communications interface. 
Video comes from the camera via either the composite (BNC connector) or S-Video port, and requires a 
video capture card or device connected to or built into your computer in order to convert the analog video 
signal into a digital one that your computer can process and display.

A typical setup: MacBook Air, MCHP, Keyspan serial adapter, USB video digitizer and cables.
[You most likely won’t be using it on a 30 year old Bausch & Lomb telescope]

In general, both of these connections are accomplished by the use of separate USB adapters, a USB-Serial 
adapter for camera communications and a USB Video Capture device to process and display video images. 
Some (primarily older or desktop) computers include built in RS-232 serial (DB-9) ports which can be used 
for communications without the need for an additional USB adapter.
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On the Macintosh, if your computer has a built in firewire port (most do), it can be used for video capture with 
an appropriate Firewire-DV converter. Because Firewire video support is built in to Mac OS X, this type of 
device has the advantages of not requiring a separate driver as well as giving higher quality uncompressed 
video images (see the section “Video Display and Capture” below for more information).

Serial Communications
Control of your MallinCam requires the appropriate MallinCam control cable connected to either a built in 
serial port on your computer or a USB to Serial port adapter. Depending on the model of your MallinCam, it 
may have one of two different serial interfaces. Cameras with a green power indicator LED have an RS-485 
serial interface, cameras with a red power indicator LED have the more common RS-232 interface. Both are 
serial communications interfaces, but the hardware is incompatible. Make sure you purchase the appropriate 
serial adapter and control cable for your model of MallinCam.

     

USB to Serial adapters are available from a variety of sources and can be purchased with one or more serial 
ports.These adapters typically require the installation of additional software and drivers usually supplied by 
the device manufacturer. Most manufactures provide drivers for both Mac OS X and Windows, but be sure to 
check for compatibility with your specific operating system before purchasing. 

NOTE: On the Macintosh, we have had excellent results with adapters from Tripplite (formerly Keyspan), 
IOGear, FTDI and TrendNet, since these manufactures provide up-to-date drivers compatible with most 
versions of Mac OS X. In addition, many inexpensive no-name USB-Serial adapters make use of the Prolific 
PL2303 chipset and there is an open source driver available here (http://osx-pl2303.sourceforge.net) which 
may work with these devices. If you already own an adapter without Macintosh specific drivers, this may be 
something to try before making an additional purchase.

In addition to the standard single port adapter, multi port adapters are available and allow connecting 
multiple serial devices (e.g. the MallinCam and the telescope mount) to a single USB port. This not only 
reduces the number of cables and connectors, but some ultra portable laptops have only one or two USB 
ports for connecting external devices.
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Before starting, make sure to set the correct camera options and serial port on the “General” tab of the 
MallinCam Control “Preferences” dialog. Failure to set these options correctly may result in a “No MallinCam 
Detected” message and/or incorrect operation of the camera.

The program will list all available serial ports in the pop-up menu. On the Macintosh, these ports generally are 
listed by the name designated in the device driver. The above device is a Prolific 2303 based USB to RS-232 
adapter made by Sabrent. Devices made by Keyspan and other manufacturers will show up differently. On a 
Windows machine, when you plug in the adapter, the operating system assigns it a "COM" (communications) 
port number. For historical reasons, this usually starts at port #3 (COM3) and counts up from there as 
additional devices are added. When setting the serial port be careful to select the appropriate one.

If you are still experiencing problems connecting to your camera, the software offers an option to log all serial 
communications. This is discussed more fully in the “Preferences” dialog help page.

Video Display and Capture
Unlike most astronomical still imaging cameras, the video image from your MallinCam is transmitted in 
analog form via a composite (BNC) or S-Video port to your computer or standalone monitor. The S-Video 
signal separates the luminance (Y) from the chrominance (C) channels, resulting in a slightly higher quality 
image compared to the composite signal, although real-world results are extremely dependent on cable 
length and quality. The two signals are usable simultaneously, and often users will connect one output to a 
monitor mounted near the telescope, while the other is connected to their computer. Viewing the MallinCam 
image on your computer requires a video capture device to convert the analog signal into a digital signal that 
the computer can process and display.
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Video capture devices are available from a number of different manufacturers, and compatibility and image 
quality can vary wildly. Although most video capture devices connect to your computer via USB, internal PCI 
card and Firewire (IEEE-1394) converters are available as well. 

When considering the purchase of a capture device, here are some things to keep in mind:

• Be certain that a driver for the device is available for your operating system. Occasionally third party drivers can be 
downloaded for free or purchased, even when the manufacturer does not provide them. 

• Be sure to chose a device with a composite video input, s-video input or both. 
• Even though the MallinCam uses a Sony CCD chip with 811x508 pixel resolution, output consists of a standard 

definition analog video signal which contains 525 interlaced vertical scan lines (NTSC; PAL devices offer slightly higher 
- 625 line resolution), of which only 483 make up the visible raster (the rest are used for synchronization and vertical 
retrace). Most video capture devices will digitize this at a standard 4:3 aspect ration of 640x480, but some devices will 
do 720x480. 

• “HD” capture devices claiming to offer high resolution may offer slightly better performance, but remember that you will 
be using the standard definition (either the composite or S-Video) input on these devices and nothing can produce a 
higher resolution image when none exists in the source. Buy a high quality standard definition device with 
comprehensive support on multiple operating systems and you will not be disappointed.

• Firewire converter devices that provide a standard DV (Digital Video) output and can be used on the Macintosh without 
any type of driver. Because these devices employ lossless compression, they produce images free from artifacts often 
inherent in other types of digitizers.

• Most (but not all) USB video digitizers are “bus powered”, most (but not all) Firewire-DV converters are not, and require 
a separate power source. 

• Not all digitizers support all analog video settings adjustments provided in the software. We are working diligently to 
make these features compatible with more devices all the time.

After connecting your capture device and installing the appropriate driver (if needed), the device should 
appear in the “Video > Video Device” sub menu. If you do not see it listed, try selecting the “Rescan...” menu 
item. This will force MallinCam Control to search for any new devices. If no devices are available, the preview 
window will display a “No Video Devices” message on a solid blue screen. 

Select your device. A “Device Starting Up” message will appear, and within a few seconds you should see a 
live image in the video preview area. A “No Video Device Selected” message indicates that no device has 
been selected in the “Video > Video Devices” sub menu. The software will remember the selected device 
between sessions and attempt to automatically select it upon launch.
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Main Window

Parts of the Main Window
The main MallinCam control window is broken up into four main areas: 

1. Video Preview Area
The video preview area shows a live display of the image being captured by your video digitizing card or 
device. Changes made to the image using the Video Filters or other effects will display here. The user can 
overlay various graphics and text information directly on top of the real-time image.

Resizing the main window (see below) will cause the video preview area to resize accordingly. If the “Video > 
Maintain Video Aspect Ratio” menu item is checked (the default), the live image will be “letter-boxed” to fit in 
the preview area without distortion, otherwise it will be stretched to fit the window.

2. Settings Pages
To the left side of the main window is the “Settings” area which is where you can adjust exposure and other 
settings on your MallinCam, modify video settings on your digitizing device, or set other live video effects 
such as frame stacking or video overlays. 
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At the top of the Settings area is a selector bar which allows the user to select from a number of different 
settings pages. Quick access to each of the “Settings” pages can be accomplished with a keyboard 
shortcut: ⌘1 through ⌘5 (Mac) or ⌃1 through ⌃5 (Windows). Most pages can be scrolled to reveal the 
various options.

3. Toolbar

The toolbar is where you will find buttons to do things like opening/saving settings files, taking snapshots, 
starting/stoping the HyperMode integration, quick access to the MallinCam Control preferences, etc. 
Centered in the toolbar is the “Information Panel”. This area gives real-time information about exposure or 
integration, shutter mode, recording state, stacking, AGC level and White Balance settings.

4. “Video Effects” header bar

This contains the digital zoom, rotate, and flip controls which which allows the user to adjust the 
magnification, orientation and angle of the displayed image – in real-time. These adjustments are done 
entirely in software on your computer. The “Reset” button will cause all video effects to revert back to their 
default values.

Full Screen and MiniController View Modes

The two buttons on the right side of the header bar are used to switch the window into MiniController or Full 
Screen view modes. 

By clicking the “MiniController” button (or choosing the “Window > Switch to Mini Controller” menu item), you 
can switch to a windowed mode, where the live video preview completely fills the main window while image 
and camera settings are moved to a small floating “Mini Controller” window. In Fullscreen mode (“View > 
Enter Fullscreen” menu item), the preview will completely fill the computer monitor and the MiniController will 
float above the image, allowing adjustments to many of the camera and video settings.

5. Status Bar
The status area shows information about the MallinCam. A progress indicator is displayed during active serial 
communications.

The main window can be resized by clicking and dragging it from any edge. The minimum size for the main 
window is approximately 950x630px, which corresponds to a preview area of 640x480px.

NOTE: Closing the main window will quit the application.

MiniController Window
The MiniController window is automatically displayed when the user enters “Fullscreen” or “MiniController” 
view modes. The window displays the same basic information as the “Information Panel” in the toolbar, 
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allows adjustment of the exposure settings, and provides buttons for starting/stoping the HyperMode 
integration, taking snapshot images, controlling the video/image sequence recording and pausing the live 
video.

 

Clicking the “Show Details” arrow  at the left of the status bar will enlarge the window to allow adjustment of 
many of the other camera, video digitizer, and filter settings. Clicking it again will minimize the window back 
to it’s original size.

The user can switch between seven different settings “pages” using either the popup menu or by clicking the 
left or right arrows in the header. The indicator “dot” changes to show which page is currently being 
displayed.

Not all of the camera and filter settings are able to be adjusted using the Mini Controller, but it allows the 
user to modify most common ones. The Mini Control window can even be moved to a different monitor than 
the full screen video preview. When in “Fullscreen” mode, clicking anywhere in the video preview area will 
hide the MiniController window, giving an uncluttered view of the live video image. Clicking again will make it 
visible.
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NOTE: Close the Mini Controller window to return to a standard windowed view.

First Light
Once your computer is communicating with your MallinCam and displaying live video, you will want to try 
your hand at using your camera to image astronomical objects through your telescope. Getting your first, 
properly exposed and focussed images can often be a challenging experience, requiring patience as well as 
trial and error. Though - with practice - you will quickly learn to use your camera to its full potential, capturing 
some beautiful images in the process.

MallinCam Settings Files
Your MallinCam can be used to view all kinds of astronomical objects from solar and lunar imaging to 
capturing faint deep sky objects (DSO’s). The MallinCam Control software includes a number of basic 
settings files which can be used to adjust your camera for various types of imaging. From the “File” menu, 
chose the “Open Settings...” menu item and open the desired file installed with the software. These files can 
be found in the “MallinCam Settings” folder which was, by default, placed in your “My Documents” folder in 
Windows or wherever you placed it on your hard drive in Mac OS X. Because of differences in telescope size, 
focal ratio and optical configurations, these settings should only be used as a starting point. Fine tuning of 
exposure settings is covered in detail in the “Camera Settings” section. Changes to camera settings can be 
saved back out to new or overwriting these existing settings files.
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Solar, Lunar and Planetary Imaging
Imaging the sun, moon and planets can easily be accomplished with even moderate sized instrumentation. 
Because of their small angular diameters, viewing details in planetary images requires high magnification, 
often achieved with the addition of a barlow focal extender. For full disk solar and/or lunar imaging, a focal 
reducer or short focal length telescope is needed. 

In “Video Mode” the live preview is updated at the standard rate of 30 frames per second (FPS) which allows 
for easier focussing and adjustment of the object’s position in the frame. Keeping the automatic gain control 
(AGC) off allows for fine control of exposure using nothing more than the Shutter Speed slider.

For some objects even the longest shutter speed (1/30th of a second) is not enough to produce a fully 
exposed image. If this is the case, selecting “SenseUp” exposure mode allows extending the exposure 
duration to just over 2 seconds.

Deep Sky Object (DSO) Imaging
A rule of thumb for imaging deep sky objects is that the larger the telescope aperture and shorter the focal 
length (lower focal ratio) the better. Although in general this is true, the MallinCam allows real time views of 
faint targets with moderate sized amateur telescopes that are impossible to obtain otherwise.

Even in large telescopes, deep sky objects generally require exposures in excess of the 2.1 seconds which is  
achievable in “SenseUp” exposure mode. The MallinCam employs a special “Hyper” exposure mode which 
achieves exposures from 3 seconds up to several minutes depending on your model of camera.
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To image DSO’s, switch the camera into “Hyper Mode” exposure by selecting the appropriate setting in the 
exposure mode popup. For the MallinCam XTreme, the extended exposure time can be adjusted in software 
from 3 to 540 seconds using the exposure slider. On the MallinCam Hyper/Hyper Plus and VSS, Hyper Mode 
exposures need to be set using either the side mounted rate adjustment knob (VSS) or with the switch 
settings on the MCHP. In this case, after changing the exposure on the camera, make sure to adjust the 
exposure slider accordingly so that the software can maintain synchronization while processing images.

Once you have selected the desired exposure, clicking the “Shutter” button will start the Integration timer and 
(in the case of the MallinCam XTreme and VSS) will send the command to start the camera integrating. Once 
the integration in complete, the software will display the image from the camera and a new exposure will 
start.

NOTE: On the MallinCam XTreme and VSS/VSS+, while the “Shutter” button is not depressed, the camera 
will display images taken at the nominal X128 Sense Up exposure rate (2.13 seconds NTSC, or 2.56 
seconds PAL).

The exposure time can be changed at any time, whether the camera is currently integrating or not.

Zooming, Rotating, Flipping and Scrolling the Live Video
The video effects header bar just above the preview area contains controls that can be used to digitally zoom 
(100% - 300% magnification), rotate (-180° to 180°) and flip (horizontally and vertically) the live video image 
on your computer monitor in real time.
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These image manipulations are done entirely in software, not on the camera, thus adjustments can be made 
at any time and the results are instantly visible in the preview area. When the video image has been zoomed 
and/or rotated so that it no longer fits in the preview area, the image can be scrolled so that hidden parts of 
the image can be brought into view. 

When the mouse is moved over the preview area the cursor will change to a “hand”. Clicking and dragging 
the image will allow the portion which is outside the preview area to come into view.

Clicking on the “Reset” button will quickly reset the settings to their default values.

Pausing the Live Video
Normally the preview area will display a live video image from the MallinCam. Keep in mind that even though 
the camera is capable of very long exposures, video output (via the composite BNC and S-Video 
connectors) occurs at the standard rate of 30 FPS (NTSC) or 25 FPS (PAL), and the camera will simply 
output a “saved” image between actual exposures. Because the software continues to display this “live” 
image, it is possible to view signal noise or loss of signal in real time. 

To stop this live update to the preview window, select the “Video > Pause” menu item or press The “Pause” 
toolbar button. This will cause the preview image to freeze and also send a command to the camera to 
freeze the video image being output. The camera will continue to function normally, but the image being 
displayed on the computer monitor or on a monitor connected to the secondary video output will not update. 
Select “Video > Resume” (or press the “Resume” toolbar button) again to resume live viewing. This feature 
can be useful when you want to view and adjust a particularly striking image without having it get replaced by 
subsequent exposures.

Taking Snapshots
Taking a snapshot of the current video preview contents and saving it as a still image to your hard drive is as 
simple as clicking the “Snapshot” button in the main window toolbar or the equivalent button in the 
MiniController window.

     

Click on one of these (toolbar button - left or MiniController button - right) to take a Snapshot

The saved image will include any enhancements that you have made using the video settings controls on 
your hardware capture device, stacking, dark frame subtraction, or video filters. They will optionally include 
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any graphic or text overlays that you have enabled. Images will be saved with the filename and to the 
location specified on the “Photos” settings tab of the MallinCam Control preferences dialog.

Recording Image Sequences
Occasionally there are times that it is advantageous to automatically save each exposure as it is completed. 
Rather than having to click the “Save Snapshot” button each time, the application provides an option to 
recored each exposure as an image sequence.

     

The “Record” toolbar button will function in this way when your MallinCam is set to “Hyper Mode” operation. 
In “Sense Up” and the two “Video” modes the button changes operation to recording movies.

Click the “Record” button to automatically save a new still image after every new hyper mode exposure or 
complete image stack if this option has been enabled (see Video Settings). Images will be saved with the 
filename and to the location specified on the “Photos” settings tab of the MallinCam Control preferences 
dialog (see Taking Snapshots for details). 

If “Frame Stacking” has been enabled, a new image will be saved each time the frame count reaches the 
selected value. For a “Rolling” stack, this will occur after the Nth frame has been collected and then for each 
integration afterwards. This results in a new image being saved each integration period. If “Rolling” is not 
selected, the frame count is reset every time N frames have been collected and the stacked image has been 
saved. This results in one new image every N integration periods. 

Image Sequences with the MallinCam XTreme
On the MallinCam XTreme, the software controls the hyper mode integration and is able to exactly 
synchronize the image capture with each new exposure. 

Image Sequences with other MallinCam cameras (MCHP and VSS)
On the MCHP and VSS the hyper mode timing circuitry is implemented within the camera itself and it is 
impossible for the software to know the exposure setting. Therefore it is imperative that the HyperMode slider 
match either the switch settings (HyperPlus) or exposure knob setting (VSS) so that a new image will be 
collected during each new hyper mode exposure.

Recording Movies
In “Video Mode” and “SenseUp” exposure modes, the function of the “Record” toolbar button changes to 
allow starting and stopping of recording the live video feed to a movie file which can be used for alignment 
and stacking of images in an external image processing program like RegiStax. In “Hyper Mode” the button 
changes operation to allow recording of image sequences.
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Clicking on the “Record” button will create a new movie file using the location and naming convention 
specified on the “Movies” settings tab of the MallinCam Control preferences dialog, and start the recording 
process. The recording state status indicator shows the total time recorded in the current movie.
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Camera Settings

Exposure
The MallinCam astronomical video CCD camera is capable of exposures from 1/12000th sec to several 
minutes, but in order to achieve this range, there are three distinct modes of operation which are described 
below.

NOTE: Switching between exposure modes is accomplished by simply choosing a mode with the popup 
menu. The software will automatically take care of adjusting all the required camera settings for the desired 
exposure mode.

Video Mode (1/12,000th to 1/60th sec)
This is the classic video camera modes of operation and is typically used for terrestrial, planetary, lunar and 
solar observing. In this mode, the camera acquires images at the standard video frame rate of either 30 FPS 
(NTSC) or 24 FPS (PAL) and exposure is adjusted by setting shutter speed.

The user can use the slider to adjust the camera’s shutter from “Off” (1/30th of a second) all the way down to 
1/12,000th of a second. Keep in mind that the MallinCam has an electronic rather than a mechanical shutter 
like many still imaging cameras.

Sense Up Mode: X2 - X128 (33ms to 2.13sec)
SenseUp (sometimes called DSS - Digital Slow Shutter) Mode is a video technology which allows extra light 
to be collected by the imaging sensor with a marked increase in low light level sensitivity. The Sense Up value 
indicates the number of video fields which are integrated before a new frame is placed into the video buffer 
and appears on the external monitor.
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In a standard video camera there are two interlaced video fields per frame, collected at 60 Hz (approximately 
16ms - NTSC) or at 50 Hz (approximately 21ms - PAL) intervals. By adjusting the Sense Up multiplier, the 
user can cause a greater number of fields to be collected, extending the shutter from X2 (33ms NTSC or 
41.6ms PAL) out to X128 (2.13s NTSC or 2.56s PAL).

An important thing to remember about SenseUp mode is that the camera still outputs frames at the standard 
PAL or NTSC rate, but the image that is displayed on the monitor will update less frequently. This can result 
in an image which appears “jerky” when centering or focussing, depending on the value of the SenseUp 
multiplier.

Hyper Mode (3sec to 540sec)
The MallinCam includes a unique “Hyper Mode” method of increasing the exposure well beyond what is 
possible with typical “SenseUp” cameras. This mode makes use of the custom “Hyper” circuitry and extends  
the exposure range from: 3 seconds out to several minutes on the MallinCam XTreme; 3 to 112 seconds on 
the VSS/VSS+; and either 7, 14, 28 or 56 seconds on the MallinCam MCHP.

When “Hyper Mode” is activated, the MallinCam’s integration buffer is reset and can take up to 3 minutes to 
build up a fully integrated image. During this time a countdown timer will display in the status area and you 
will be unable to initiate the integration sequence. Once the timer has counted down to zero, you can click 
the “Start Integration” button to begin the first exposure.

 Setting Hyper Mode exposure times varies depending on your model of MallinCam.
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• MallinCam Hyper and HyperPlus (Color or B/W) – The MallinCam Hyper has two long exposure modes - 7 seconds 
and 14 seconds, activated by the use of switches on the side of the camera. The MallinCam HyperPlus adds two 
additional exposure settings (28 and 56 seconds).  Unfortunately there is no way for the the MallinCam Control 
software to determine the current hyper mode exposure switch settings, and requires the user to adjust the slider 
when the switch positions are modified. Doing so insures that saving of image sequences and frame stacking/
averaging will be synchronized with the long “hyper” exposure settings.

• MallinCam VSS and VSS+ – Adjusting Hyper Mode exposure settings on a MallinCam VSS (or VSS+) is accomplished 
with a side mounted knob, rather than switches like on the MCHP. This allows totally variable exposures between 3 
seconds and either 56 seconds or 112 seconds depending on the setting of the “X2” checkbox which causes the built 
in electronics to double the exposure time set on the control knob. Just like with the MCHP, you should always adjust 
the HyperMode slider to match the exposure time set on the Rate knob.

• MallinCam XTreme – Hyper Mode exposure settings on the MallinCam XTreme are entirely dependent on either 
computer control or the wireless shutter controller. One distinct advantage of this is that exposure times are infinitely 
variable and when computer controlled, collected images are perfectly synchronized with the exposure time.Use the 
slider to select the desired integration time which is adjustable in 1 second increments from 3 to 240 seconds. To 
begin an exposure, click the “Shutter” button below the video preview and the camera will begin integrating. When the 
full integration is complete, the captured image will be displayed and a new exposure will begin automatically.The 
exposure time can be adjusted at any time. If an integration is currently in progress, the new exposure time will begin 
when the current exposure finishes. 

NOTE: While the “Shutter” button is not depressed, the MallinCam XTreme and VSS cameras will display 
images taken at the nominal X128 Sense Up setting (2.13 seconds NTSC, or 2.56 seconds PAL).

Automatic Gain Control (AGC)
The AGC setting controls the final CCD amplifier gain on the MallinCam. It functions in all exposure modes 
and is one of the most important settings for controlling image appearance. For lunar and planetary 
observing, the recommended setting is to turn ACG “Off” and rely on the shutter speed setting to control 
exposure. Since the output amplifier amplifies sensor and electronic noise as well as image data, it is (in 
general) best to use as low a setting as possible to obtain the desired result. A general rule of thumb is to 
start with AGC at around 3 or 4 and adjust as necessary.

NOTE: In Hyper integration mode, whenever the AGC setting is changed, the integration buffer is 
automatically reset and the countdown timer will begin anew.

The AGC slider is disabled while actively integrating in “Hyper Mode”. To change the AGC setting, click the 
“Shutter” button to stop the current exposure, change the value, wait for the countdown timer and start a 
new exposure.

White Balance
White Balance is a means of assuring that objects that are white actually appear white in your image. This 
option is only available on color capable cameras.
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There are five options available:

1. ATW (Auto Trace White-balance): Recommended for most DSO observing
2. AWC (Auto White-balance Control): Direct the camera toward a white wall and press the “Set” button. 
3. 3200°K (“Indoor” setting, fixes the color temperature to Tungsten lighting)
4. 5600°K (“Outdoor” setting, fixes the color temperature to Daylight)
5. Manual: This should be used when observing under urban, light polluted skies. Recommended settings are Red: 2 

and Blue: 5, but these can be adjusted to achieve the best image.

Gamma

This controls the output Gamma setting of the video processor. Selecting the gamma setting of 0.45 will 
show the most detail but will also result in a slightly brighter background. A gamma setting of 1.0 will result in 
a slightly darker image and is best for use with an LCD monitor or a video digitizing device. The gamma 
setting affects the output of both the composite and S-Video outputs.

Advanced Pixel Control (APC)

APC is used to control on board horizontal and vertical image processing done by the MallinCam. The user 
can adjust both horizontal and vertical levels to provide the best output image. The default setting in both 
dimensions is 8 and generally, when imaging deep sky objects (DSO’s) the values should be set to their 
minimum to reduce the appearance of warm and hot pixels on the sensor.
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Higher settings can be used to bring out details in lunar or planetary images but will often result in star 
images with dark centers or “halos”. For most DSO observing, low to medium values are recommended.

Highlight (Coronagraph)

Highlight is used to artificially darken bright areas on the video image. When viewing the sun through a 
Hydrogen Alpha filter, the “Highlight (Coronagraph)” slider can be used to effectively block out the bright 
surface of the sun allowing the solar prominences to be seen more easily.

Mask (Video Crosshairs)

The MallinCam has the capability to display up to 4 independent rectangular “mask” areas which can be 
used to obscure an area of the image. By carefully placing them as thin rectangles, they can be made to 
appear as “crosshairs” which, since they are generated in the video circuitry of the camera itself, are part of 
the video signal and can be seen on any monitor connected to your camera. The software can display these 
“pseudo crosshairs” in one of three styles: Single, Double or Box.

Camera Output

The Camera Output options can be used to modify the video output signal on your camera. The  Color Bar 
(Grey Bar) screen can be used to calibrate your monitor or image capture device.

Flip Horizontal and Flip Vertical are used to adjust the video image to match an objects true orientation. The 
is commonly used for lunar, solar and planetary viewing.
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The Zoom checkbox will activate the camera’s built in electronic zoom function. The amount of zoom can be 
adjusted between 1x and 2x. NOTE: Because zooming occurs in steps within the camera, if the MallinCam is 
set to a long exposure mode (Sense Up or Hyper Mode), it will take several image refreshes (one for each 
step) to arrive at the final zoom value and the camera will be unresponsive until the new zoom setting has 
been achieved. For this reason, camera output changes are disabled while the camera is actively integrating 
in “Hyper Mode”.

Unlike similar settings in the Video Effects header bar, these options affect the video output of the camera 
itself and can be seen on a monitor connected to the secondary video connector as well as the preview 
pane.

Peltier Cooler (TEC)

The mild peltier thermo-electric cooler built into the MallinCam is designed to cool the CCD sensor in one of 
two modes: “Automatic” (0 through 8) and “On” (Continuous). 

• Automatic (0 - 8): In “Automatic” mode, each frame is analyzed for noise and, if detected, the Peltier cooler is turned 
on for a fixed amount of time during the next frame. The slider adjusts the degree of cooling which is performed, with 0 
being the minimum, and 8 being the maximum automatic setting.

• On: When set to “On”, The TEC will operate in a 100% duty cycle mode. This is the preferred setting for the longer 
integration times needed for observing DSOs. The disadvantage of running the Peltier cooler continuously is that 
condensation can form on the front surface of the CCD causing stars to appear blurry.

NOTE: The Peltier Cooler adjustment only functions on the MallinCam XTreme and VSS cameras. The 
MallinCam Jr. Pro has no built in cooling, and the MallinCam HyperPlus uses a toggle switch on the side of 
the camera to turn the cooler on and off. There is no way to completely turn the TEC off on a VSS or 
XTreme, but setting the cooling level to 0 will result in the least amount of cooling.
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Video Digit izer Settings

The Video Digitizer Settings page is where the user can control signal levels and other options on their 
capture device. Settings made here are applied on the video capture device and will only be visible in the 
preview area, not on a monitor connected to the secondary video output of your MallinCam.

Video Settings
These adjustments all modify settings on your hardware video capture device (MCV-1, Canopus, Dazzle, 
etc.). Keep in mind that not all settings will function with all devices. This is entirely dependent on the device 
and/or the support built into it’s driver (if any). 

Since each video capture device is different, values are adjusted and displayed as a percentage of their 
maximum rather than their absolute value. Adjustments take place in real-time as the user moves the slider 
with the mouse. Clicking in the bar on either side of the slider handle will cause the setting to jump in 
increments 10%. Fine adjustments can be made by clicking the up/down button to the right of the slider. 

Clicking the Reset button will cause the values to revert to their default positions (which are device 
dependent). 

MallinCam Control User’s Guide 26

Copyright © 2012-2013, MiloSlick Scientific



NOTE: Remember that adjustments to these settings cause significant changes to the displayed image and 
will require substantial changes to the other video filters. It is recommended that you make adjustments 
here before enabling and fine tuning any of the other video filter settings. Video Setting adjustments are 
disabled when Frame Stacking is enabled.

Video Smoothing

The Video Smoothing slider can be used to help reduce the effects of noise introduced by the hardware 
compression used in most video digitizing devices. Smoothing is performed entirely in software and can 
dramatically improve the live images, though CPU requirements tend to be high.

Video Frame Rate

In normal operation, your video digitizing device will collect and process frames as quickly as possible. The 
actual frame rate will depend on your digitizer, the speed of your computer and the bandwidth of the USB (or 
other port) that it is connected to. By limiting the frame rate to a value below the maximum rate possible with 
your hardware configuration, you can often limit the CPU usage needed by the MallinCam Control software.
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Frame Options

Frame Stacking
You can use this option to sum or average 2 to 10 video frames to dramatically increase sensitivity or 
decrease image noise. Unlike post processing software like Lynkeos or Registax, this processing is 
calculated and displayed in real-time in the MallinCam Control preview area.

Averaging/Summing
Frame stacking is the process where N individual images are placed over top of each other and summed or 
averaged, pixel for pixel, to create a new image that has greater dynamic range and a higher signal to noise 
ratio. A “summed” stack will produce an image N times brighter than the individual images, whereas an 
“averaged” stack will be approximately the same brightness.
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Select the number of frames (N) which you would like to sum or average and check the “Enable” checkbox. 

Rolling
A non-rolling N-frame stack will result in an update to the preview image every N times the selected 
exposure. For example: If you have set a 20s HyperMode exposure value and have selected a 2 Frame 
discrete (non-rolling) stack, the preview would update every 40s.

Avg 1&2

Frame 1
20s exp.

Avg 3&4

Frame 2
20s exp.

Frame 3
20s exp.

Frame 4
20s exp.

Preview Update (40s later)

2 Frame Stack - Rolling Disabled

Initial Preview Update

When the “Rolling” checkbox is enabled, after the first N exposures are collected, a new image will be 
displayed in the preview window with every new exposure. The first image in the stack will be dropped and 
the new image will be added to the end of the stack, assuring that there are always N frames to process. 
The example below shows a simple 2 frame rolling stack, though it can easily be extended to include any 
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number of frames (up to 10). Just beware that the initial image will not be displayed until a full N exposures 
have been taken.

Frame 1
20s exp.

Avg 3&4

Frame 2
20s exp.

Frame 3
20s exp.

Frame 4
20s exp.

Preview Update (20s later)

2 Frame Stack - Rolling Enabled

Avg 2&3

Initial Preview Update

Preview Update (20s later)

Avg 1&2

When the MallinCam is operated in standard video (non Hyper) modes, video frames are sent captured by 
the video digitizing device at the standard video frame rate (24 or 30 FPS) and stacking will occur at this 
native frequency. When Sense Up is turned on (X2 to X128), new images are captured by the camera at 
longer intervals and results in a non true image stack. 
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In Hyper Mode, new frames are synchronized to the long exposure times and stacking/averaging will occur 
only on new images which occur after each exposure is completed. This is unlike the frame stacking filters 
available in other software packages which have no mechanism of knowing when new Hyper Mode 
exposures have been completed.

Dark Frame Subtraction
This feature will allow you to take a “Dark Frame” and subtract it in real-time from all subsequent incoming 
video frames. When done correctly, dark frame subtraction can be used to to reduce the appearance of amp 
glow, warm pixels and dark current noise common with long exposures. Once the dark frame has been 
acquired, you can subtract it from all incoming video frames by checking the Enable checkbox. This 
provides a way of instantly seeing the effects of this filter on the live video image.

Capturing Dark Frames
The Capture button will save the current raw video frame as a dark frame image. Cover your scope, let the 
exposure complete then press the Capture button. A thumbnail of the captured image will be displayed in the 
dark frame preview area.

It is also possible to add a residual image to the current Dark Frame, making it possible to drastically improve 
results by removing additional video compression artifacts which remain even after the initial Dark Frame is 
subtracted. To accomplish this follow these steps: 

1. Chose a Hyper Mode exposure and start integrating.
2. Capture a Dark Frame normally by clicking the "Capture" button while keeping your telescope covered. 
3. Once the DF has been captured, without removing the cover, check the "Enable" checkbox to start subtracting the DF 

from the live incoming video. You will notice that there are occasional (every few seconds) frames that are not 
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completely black as would be expected. This effect is due to slight differences in the video compression artifacts that 
surround the hot pixels in your dark image.

4. When one of these (non-black) frames is being displayed, quickly hold down the "Shift" key and click the "Capture" 
button a second time. This will add the residual image to the original DarkFrame, dramatically improving its effect. 

Using Stored Dark Frames
The Load... and Save... buttons allow you to save to and load dark frames to disk as standard JPG images 
(with no compression). When saving, the filename defaults to "Dark Frame" with the current integration time 
appended in parentheses. Since hot pixels, amp glow and dark current change very little over the life of a 
CCD sensor, this feature can be used to store a collection of dark frame images, taken with various lengths 
of exposure, that can be loaded and used without having to go through the trouble of taking new ones each 
observing session. 

Adjusting the Dark Frame Level
The Level slider will adjust the scaling of the dark frame that is subtracted from the raw video (from 0% to 
200% of the original). This allows you to fine tune the subtracted dark frame to effectively remove most 
artifacts without removing too much of the exposed image.

The Scale automatically with exposure option will automatically adjust the dark frame level whenever the 
integration time is changed. The software “remembers” the exposure time when a dark frame is captured or 
loaded, and will adjust the scaling factor independently of the manual adjustment as the exposure is 
changed, up or down. When this option is checked, the actual scaling factor is determined by the following 
equation:
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Hot Pixel Removal
“Hot Pixels” are individual sensors on the CCD chip which have a higher than average rate of charge 
leakage. They appear as bright points of light in long exposures. The Hot Pixel Removal tool will intelligently 
replace hot pixels with an average of the image data surrounding them. In this way, hot pixels can be 
removed from an image without causing the “black holes” which are a common problem when simply 
subtracting a “dark frame” from the image.

The user can define as many hot pixels as they would like. Hot pixels are specified by their (x,y) coordinates 
(on the digitized image, not on the CCD sensor), their brightness (in A/D counts),  and their size in pixels.

Using the Tool
Cap your telescope and set the Hyper Mode exposure to a reasonably short duration (5-20 seconds is 
plenty). The TEC (Peltier) cooler level should be close to a value that you use for most of your observing. 
Cooling the sensor appropriately will assure that only “hot” pixels (those which are *always* visible in your 
image) and not “warm” pixels (those which are thermally generated) are being defined. After the camera has 
stabilized, you should have an image like the one below.
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MallinCam XTreme “Dark Frame” - 10s exposure, AGC: 3, maximum cooling

In this image we can easily see three bright hot pixels and four (or five) dimmer ones. We will first concentrate 
on defining the brightest - white - hot pixels in the image.

Adding and Removing Hot Pixels
Click the “Add” (+) button, and move the cursor over the dark frame image in the preview area. Carefully 
center the crosshairs on the middle of the “hot pixel” and click the mouse button.

     
An entry will be made in the hot pixel list box, the entry will be “selected” and a small “target” will be 
displayed over the hot pixel.

The tool will choose the smallest size which corresponds to an 80% drop in brightness from the user defined 
center of the hot pixel. This size is the region of the image which will be replaced when the filter is enabled.

Define as many hot pixels as you find appropriate. If you make a mistake, select the entry in the list and click 
the “Remove” (-) button to delete it.
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Multiple entries can be selected simultaneously by clicking on them while holding down the Shift or Controls 
(Option) keys. Selected hot pixels are shown in the preview area with the red “target” icon.

Once you have defined all your hot pixels, click the “Enable” checkbox and they should magically disappear 
from your image!

Same image as above but with “Hot Pixel Removal” enabled...

If you find that one or more of the hot pixels is not completely removed, increasing the size of the area to be 
replaced will usually take care of the problem. Select one or more pixels in the list, click the “Size >” button 
and choose the appropriate dimensions in the popup menu (from 1x1 pixel to 5x5 pixels).

Using the Auto Detect Feature
The “Auto” button can be used to automagically detect all the hot pixels in a dark frame image. Set your 
exposure appropriately, and start the camera integrating while fully covered. Select a “Level” to be used for 
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hot pixel detection. Pixels darker that the selected value (as a % of the full brightness) will not be analyzed.  
Clicking “Auto” will scan the image, and add each hot pixel that it finds to the list. 

If the tool did not detect all the hot pixels in the image, you can try lowering the detection threshold (level) 
and clicking the “Auto” button again. Duplicate entries will be ignored, and new ones will be added to the 
end of the list. The auto-detect tool uses the same algorithm to determine the minimum size of the hot pixels 
area (average surround is 80% darker than the centroid).

Saving and Loading Hot Pixel (.HPX) Files
Since Hot Pixels are part of the CCD sensor itself, they are relatively stable over the lifetime of the camera. 
The Hot Pixel Removal tool provides a way of saving a set of defined hot pixels to a file for use later. The 
“Save” and “Load” buttons can be used to manage a set of hot pixel “map” files (extension .hpx) on your 
hard drive. These files are stored in plain text format and can be edited in any plain text editor if needed.
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Filter Settings

The Filter Settings page contains a collection of software video processing filters designed to enhance the 
output from your MallinCam camera. These filters improve the image in a way that is simply impossible to 
achieve using only the basic video controls built into your digitizing device (Brightness, Contrast, etc.).

Amp Glow
Amp Glow is the pattern of light visible in long CCD exposures that is brightest in the corner and decreases 
toward the center of the image. It is caused by light emitted by the readout amplifier and protection diode on 
the MallinCam's CCD chip. This filter will subtract the specific color in the user defined radius and optionally 
replace it with a gradient color fill to match the background of the unaffected portion of the image.

Position and Size
X/Y Pos: Since the amplifier glow doesn’t come from the exact corner of the CCD, these let you adjust the 
horizontal and vertical offsets of the applied filter. 

Radius: This sets the size (in pixels) of the circular Amp Glow filter.

Blur: This controls the size of the blurred edge of the Amp Glow filter, as a percentage of the size of the 
circular area defined by the Radius setting. Blurring is currently accomplished using a basic “box blur” effect 
since this is relatively processor non-intensive. Improvements to this will be forthcoming.
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Brightness and Color

Remove: This allows you to set the amount of amp glow which gets removed 
from the raw image. By clicking on the colored rectangle to the right side of 
the slider, you can select the specific color marked for removal using the 
standard Mac OS X or Windows color picker. 

Add: Because removing the amp glow will often result in a dark area in the 
corder of the image, this setting allows you to fill in the resulting “hole” with an 
adjustable value and color to match the background of the rest of your image. 
Clicking on the rectangle will let you chose the fill color.

Click the Reset button to set all adjustments back to their default values.

Vignetting
The Vignetting filter can be used to reduce the darkening in the corners of an 
image which is a common effect of excessive focal reduction.

Radius: This refers to the percentage of the full frame that will be corrected. The “mask” is centered on the 
middle of the image and will affect each corner of the image equally. 

Blur: This controls the size of the blurred inner edge of the vignetting mask, in pixels.

Multiplier: The multiplier affects how much the filter will increase the brightness in the masked area. The filter 
does not simply add a gray colored mask over top of the image, but instead performs a more processor 
intensive technique of multiplying the existing image data in the masked area by this factor.

Miscellaneous
These filters can be used to modify and improve the preview image for best results. All filters are performed in 
software and can be enabled/disabled at any time.

Grayscale
Converts the color image to grayscale using one of four techniques:

• Average: Y = 0.33R + 0.5G + 0.16B
• Weighted Avg: Y = 0.375R + 0.5G + 0.125B
• Photometric ITU-R: 0.2126R + 0.7152G + 0.0722B (double precision)
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• Digital NTSC/PAL CCIR601: 0.299R + 0.587G + 0.0114B (double precision)

Invert Image
Inverts the color data on the image

Warp Sharp
Performs a sharpening convolution effect on the live image. This can be used to bring out additional detail.

Mean Removal
Greatly sharpens the image using a MeanRemoval function. MeanRemoval is a more extreme type of 
sharpening function than WarpSharp

Edge Detect
Detects edges in the image using the EdgeDetect function. This filter will leave the image black with colored 
edges.

Digital Smoothing
Smooths the image using variable weighting

Histogram 
The new Histogram can be used to improve the appearance of nebulae, galaxies, etc. by applying levels 
changes to the live image for each color channel independently, or for a combined Intensity (Y) channel.

Input Levels
These values specify the lower and upper brightness limit for the image. Data above and below these levels 
is discarded.
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Output Levels
Changing the output levels stretches and converts the input to the new values. Most of the time these values  
are left at 0 and 255 counts (full black to full white).

In the graph above, sky background below 73 counts will be discarded and converted to 0 counts (full black) 
in the processed image. Image data above 208 counts is similarly discarded and the processed image is 
“stretched” so that 208 counts of brightness is redrawn as full white (255 counts). The effects of these levels 
settings can be seen in the two images of M16, the “Eagle Nebula” shown below.

     
M16, Eagle Nebula: Before (left) and after (right) Histogram levels adjustment. Click to enlarge

Changes to these adjustments should be made gradually, in small increments. Excessive adjustments to 
either setting can result in a overly contrasty, grainy images.
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Video Overlay Settings

Graphic Overlay
MallinCam Control allows you to chose from a number of standard crosshair, graduated or astrometric 
reticles, and grids which can be scaled, rotated, and adjusted, over top of the live video image. All 
adjustments can be made using the sliders or up down arrows for fine tuning.

Style
Choose From nine different circular crosshairs and two different grid shaped overlays shown in the image 
below.
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Reticle selection available in MallinCam Control

Size
Reticle size is adjustable from 50% to 200% of the default, full frame size.

Rotation
Can be adjusted in CCW 1° increments.

Brightness
Defines the brightness value for the overlain graphic

Transparency
Alpha channel transparency of the graphic overlay

Color
Basic color of the graphic overlay. Four choices are available, White, Red, Green and Blue.
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Text Overlay
The software currently supports four basic text overlays described below. The user can select the size (6 to 
64 points) and color (by clicking on the colored rectangle) of the overlay, but all text overlays will be displayed 
with the same attributes.

Time Stamp
This option places the date and time, formatted using your system settings, in the upper left corner of the 
image.

Camera Information
Displays the model of camera as well as the type of sensor, as defined in the General tab of the Preferences 
dialog.

Exposure Settings
Shows either a compact version of the MallinCam exposure and image settings, or an expanded version 
which just contains the current exposure settings. The “Compact” notation includes the following settings, 
enclosed in square brackets, separated by the pipe “|” symbol:

[SenseUp|Exposure|AGC Setting|White Balance|Zoom|APC Setting (H&V)|Gamma]

Text Comment
can be used to add your own description or other information limited only by the amount of text which can 
be displayed in a single line.
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Mall inCam Control Preferences

Click the “MallinCam Control > Preferences...” (Mac OS X) or “Edit > Preferences...” (Windows) menu item to 
open the MallinCam Control Preferences dialog.

General Preferences

MallinCam Options
Here is where you should specify your model of MallinCam, its sensor type, video format (NTSC or PAL) and 
the serial port that the camera control cable is connected to. Failure to correctly identify your camera can 
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result in improper operation and loss video output while under software control. The video format option is 
used to correctly calculate exposure times while the camera is used in “Sense Up” exposure mode.

MallinCam control builds a list of all serial ports connected to your computer when it is launched. If you plug 
in a USB-Serial adapter after MallinCam Control is running, it will not display in the drop down menu. Quit 
and relaunch the application and your adapter should be listed. If not, check that you have the correct device 
driver installed and working. On the Mac this can be determined by clicking “About This Mac” in the Apple 
menu and clicking the “More Info...” button. In Windows, run “Device Manager” to determine if your serial 
port is functioning correctly.

Serial Communications Logging
The communications logging option logs all input and output to either the “Console” application (in Mac OS 
X) or to the Windows debug log.

On the Macintosh, “Console” can usually be found in the “Utilities” directory which is in the “Applications” 
directory of your hard drive.

To see the log output in Windows, you'll need to download Microsoft's DebugView application from here: 

http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx

This program lets you look at debug logs generated by Windows, MallinCam Control and other software 
installed on your machine. There is no installer, just place the executable in a convenient place on your hard 
drive. 

Software Update
When checked, MallinCam Control will automatically check for updates and alert you when they become 
available. It is recommended that you leave this option checked to be assured that you always are running 
the latest and best version of the software. If you would like to be informed when pre-release versions of 
MallinCam Control are made available, uncheck the “Final releases only” checkbox.

When a new release is made available, a dialog box will appear and prompt you to download it to your 
computer. After downloading, simply quit MallinCam Control and copy the new version to your “Applications” 
folder (Mac OS X) or run the downloaded installer (Windows) to update your software.

Miscellaneous
Here you will find the option for playing a sound when the integration completes. Because the MallinCam 
operates continuously while imaging, there is no indication from the camera itself when the Hyper Mode 
exposure has completed and it has begun a new one. This option can serve as an audible indicator for when 
you can not watch the exposure timer on your computer screen.
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Photo Preferences

Photo Files
Save Photos to: 
Use the popup menu to chose a folder where photos should be saved. The menu contains some common 
locations and includes an option to “Choose” a custom location. The location is automatically saved and will 
be used each time you run MallinCam Control.

Filename:
• Ask: The software will display a “Save As...” dialog box each time a new snapshot is taken.
• Timestamp: The filename for the saved image will automatically be determined by your system time and will be in the 

format - YYYYMMDD.HH.NN.SS.jpg. 
• Sequential with Custom Prefix: This option can be used to save multiple images with the same file prefix (e.g. 

“NGC891_” or “CrabNebula”) and a four digit value will be automatically appended and incremented as each photo is 
saved. Remember to include some type of delimiter (the above example uses an underscore character) if your prefix 
ends in a numerical digit to avoid confusion with the appended suffix. The current image sequence value is 
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automatically saved loaded each time you run MallinCam Control. Click the “Reset #” button to reset this value back to 
zero (“0000”).

Picture Options
Feedback:
Specifies whether a shutter sound will be played when taking snapshots. 

Overlays: 
Select this option to include graphic and text overlays in the saved image files. Video overlays include the 
reticle images, and text overlays. Unchecking this option will not remove the “Unregistered” watermark.

Image size: 
Specify the desired size for saving images. Images are scaled (up or down) to match the selected resolution 
using antialiasing. 

Image format: 
Select the desired image file format. Options include:

• PNG - Portable Network Graphics: An open extensible graphics format with lossless compression. This is a modern 
graphics format good for emailing or including on web pages.

• PICT - Macintosh Graphics Format: The native graphics format used on the Macintosh computer since 1984. This is 
available on the Macintosh version of the software only.

• TIFF - Tagged Image File Format: A file format for storing images, popular among graphic artists and the publishing 
industry. This a a lossless format, but files tend to be much larger than those saved as PNG or JPEG. 

• JPEG - Joint Photographic Experts Group: A commonly used method of lossy compression for digital photography. 
More common than PNG with user selectable variable compression and optional EXIF data.

JPEG Options: 
JPG files can be saved with a user selectable quality setting, 100% being the least amount of compression 
but also resulting in the largest file size. EXIF header data is not currently supported.
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Movie Preferences

Movie Files
Save Movies to: 
Use the popup menu to choose a folder where movies should be saved. The menu contains some common 
locations and includes an option to “Choose” a custom location. The location is automatically saved and will 
be used each time you run MallinCam Control.

Filename:
• Ask: The software will display a “Save As...” dialog box each time a new movie recording is started.
• Timestamp: The filename for the saved image will automatically be determined by your system time and will be in the 

format - YYYYMMDD.HH.NN.SS.jpg. 
• Sequential with Custom Prefix: This option can be used to save multiple movies with the same file prefix (e.g. “Jupiter” 

or “VenusTransit”) and a four digit value will be automatically appended and incremented as each movie is recorded. 
Remember to include some type of delimiter (e.g. an underscore character) if your prefix ends in a numerical digit to 
avoid confusion with the appended suffix. The current movie sequence value is automatically saved loaded each time 
you run MallinCam Control. Click the “Reset #” button to reset this value back to zero (“0000”).

Movie Options
Setting of movie options directly from the preferences dialog is not yet supported and will appear in an 
upcoming release of the software. Movies are currently saved using the quality and compression settings of 
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your video capture device. On Mac OS X, these settings can be adjusted in the “Video Options...” dialog box 
accessible in the “Video” menu. 
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